
 

 

 

 

 

 

 

  

 

 

User Manual 



 

 

 

User Manual 

RGB Lasersysteme GmbH 

Qstick Spectrometer 

Version: 1.0.3 

Date: November 04, 2013 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This document is protected by copyright. Do not copy or publish this document or parts 

of it without written permission of RGB Lasersysteme GmbH. 

Product specifications and descriptions in this manual are subject to change without 

notice. RGB Lasersysteme GmbH will not be responsible for errors and omissions in this 

manual or for direct or incidental damages in connection with the use of this device or 

information. 

 

© 2012 RGB Lasersysteme GmbH 

Donaupark 13 

93309 Kelheim 

Germany 

Telephone:  +49 9441 1750 33 --- 0 

Website:  http://www.rgb-laser.com 

E-Mail:  sales@rgb-laser.de 

  



 

Contents 

1 Introduction ...................................................................................................................... 1 

1.1 Product Overview ....................................................................................................................... 1 

1.2 System Requirements ............................................................................................................... 2 

1.3 Package Contents....................................................................................................................... 2 

2 Installation ......................................................................................................................... 3 

2.1 On-board USB memory drive ................................................................................................. 3 

2.2 PC Setup ........................................................................................................................................ 3 

2.3 Optical Setup ............................................................................................................................... 4 

2.4 Troubleshooting ......................................................................................................................... 4 

3 Operation ........................................................................................................................... 6 

3.1 Introduction ................................................................................................................................. 6 

3.2 Overview ....................................................................................................................................... 6 

3.3 Taking Spectra ............................................................................................................................. 7 

3.4 Spectrum Display ....................................................................................................................... 8 

3.5 Working with spectra ................................................................................................................ 9 

3.6 File Operations .......................................................................................................................... 10 

3.7 Spectrum Analysis .................................................................................................................... 11 

3.8 Absorption, Reflection and Transmission Measurements ........................................... 12 

3.9 Calibration .................................................................................................................................. 14 

4 Software Development Kit ....................................................................................... 18 

4.1 Prerequisites .............................................................................................................................. 18 

4.2 Getting started .......................................................................................................................... 18 

4.3 Classes Overview ...................................................................................................................... 18 

4.4 Adding the SDK library to your project ............................................................................ 19 

4.5 Taking a spectrum .................................................................................................................... 20 

4.6 Deploying your project .......................................................................................................... 20 

5 Technical Support ........................................................................................................ 21 

5.1 Getting Help ............................................................................................................................... 21 

5.2 Software Updates ..................................................................................................................... 21 

6 Specifications ................................................................................................................. 22 

7 Certifications and Compliance ................................................................................ 23 

 
 





Introduction 

 1

1 Introduction 

1.1 Product Overview 

The Qstick contains a complete spectrometer in an extraordinarily small USB stick design. 

The wavelength range covers the whole visible spectrum from 360 to 740 nm with a 

resolution of 1.2 nm. It is controlled and operated by the spectroscopy software ‘‘Waves‘‘, 

which not only includes unique sophisticated algorithms for data acquisition and 

evaluation, but also provides these features through a clear and straightforward 

interface. The Qstick includes an USB flash drive containing the device drivers and 

application software. 

Qstick Hardware Features 

o Subminiature design 

o Spectral resolution of  1.2 nm 

o 2500 pixel CCD sensor 

o Optical input via SMA fiber  

o Controlled and powered via USB 2.0 

Waves Software Features 

o Take and display series of spectra 

o Dynamic exposure control with dark spectrum interpolation 

o Import most ASCII-based file formats 

o Export as ASCII table to almost any numerical analysis software 

o Comprehensive tools for displaying and analyzing spectra 

o  ‘‘Strip charts‘‘ for comparing characteristic values between multiple spectra 

including peak follower 

o Graph printing and export to PDF 

o Dynamic peak finder (no need to set a threshold level) 

o Automated wavelength calibration 

o Dark spectrum interpolation 

o Transmission, Reflection and Absorption measurements 

o Colorimetry 
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Applications 

o Portable measurements 

o Colorimetry 

o Light analysis 

o Forensic analysis 

o System integration 

o Process control and monitoring 

1.2 System Requirements 

o Windows 8, 7, Vista or XP (32 or 64 bit) 

o .NET Framework Version 3.5 (available as a free download) 

o USB 2.0 

1.3 Package Contents 

o Qstick spectrometer 

o Waves spectroscopy software, device driver, and this manual as PDF (on the USB 

memory drive included in the device) 

o Printed user manual 

 

 

 

 

 

 

 

 

 

 

 

 

 

Visit us at www.rgb-laser.com if you need any accessories for your spectrometer. 
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2 Installation 

2.1 On-board USB memory drive 

The Qstick includes an USB memory drive. When you connect the Qstick to a PC, this 

drive appears with a new drive letter in the Windows Explorer. It contains the drivers, 

application software and a PDF file of this manual. 

2.2 PC Setup 

Please install the software by double-clicking on the WavesSetup.exe file on this drive. 

The setup package then installs the application software and the device driver. 

Afterwards you can start taking spectra with the application software Waves. 

The software is tested with 32 and 64 bit versions of Windows 8, 7, Vista and XP. It 

requires at least the Microsoft .NET framework version 3.5, which is already installed on 

most PCs. It also works with .NET framework version 4.0. If this framework is not installed, 

you can download it from Microsoft’s website.  

You can install the software on as many computers as you like. For example, you may 

want to install it in the lab for measurements and in your office for further spectrum 

analysis. Please visit our website for software updates. 

The device driver for the Qstick spectrometer is not fully certified yet. If Windows displays 

a warning, please choose to install the driver anyway. (You can be assured that is does 

not contain any malicious software.) 

The USB port needs to supply an electrical current of 200 mA, so you need to either 

connect the spectrometer directly to your computer or to an externally powered USB 

hub. A flashing red LED on the device indicated that the port does not supply enough 

power. 

When you start the Waves software, it automatically searches for the Qstick 

spectrometers and, if it finds one, initializes the device. If you attached it just before, it 

may take a few seconds before the spectrometer is properly recognized by the operating 

system. The initialization takes a couple of seconds during which the software loads the 

calibration data from the device. 

If the software finds no or several spectrometers while starting, it displays a dialog 

window from which you can choose a device or decide to use a ‘‘Simulated 

spectrometer’’ instead. This simulated spectrometer can be used to evaluate the software 

without connecting an actual device. You can access this dialog window later on by 

choosing ‘‘Device Setup’’ from the File menu. 
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2.3 Optical Setup 

The light enters the Qstick spectrometer through a small slit. You can see this slit if you 

look into the fiber optical connector on the front side of the device. 

If the light you wish to measure is quite strong, you may simply point the spectrometer 

towards it. For example, you can test the spectrometer by pointing it towards your 

computer screen or your desk light. 

In most cases, however, you’ll need a special optical probe to collect as much light as 

possible. In order to guide the light from the probe to the spectrometer, use a fiber 

optical cable with SMA connector  like the one from the Qstick package. 

We recommend standard fiber optical cables with a core diameter of 200 µm and a small 

numerical aperture. If you’re using a fiber with a smaller diameter, you’ll get a slightly 

better resolution and sensitivity, but you may find it more difficult to focus the light into 

the fiber. If you’re using a larger fiber, the spectrometer cannot detect all of the light 

coming out of the fiber and the stray light is slightly increased. 

PLEASE NOTE: The calibration for the spectral sensitivity correction and the optical 

power was made with a 200 µm fiber optical cable. If you use a different fiber or 

especially if you just point the spectrometer towards the light source, the measured 

spectrum might not be accurate. If you have a calibrated light source, you can always 

recalibrate the spectral sensitivity for any optical setup (see chapter 3.9). 

If you focus the light directly onto the entrance slit, you’ll get the best sensitivity and 

lowest stray light if you make sure that: 

o The focused light is centered on the entrance slit, 

o the height of the light spot on the entrance slit is 200 µm or smaller and 

o the numerical aperture of your focusing optics is close to 0.07, matching the 

numerical aperture of the spectrometer. 

If your focusing optics has a larger aperture than 0.07, you loose some intensity inside the 

spectrometer. On the other hand, a numerical aperture significantly smaller may lead to a 

decrease in resolution. 

2.4 Troubleshooting 

The green light on the spectrometer is off, the red light is flashing or lit 

continuously and the device does not react 

This indicates that the device has turned itself off because the USB port was not able to 

supply enough power. This also may happen if the USB cable is too long or damaged. 

Please disconnect the device and try a different USB port or cable. 
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Waves cannot find the device 

Please disconnect and reconnect your spectrometer, close the ‘‘Device Config’’ window, 

wait a few seconds and open this window again from the File menu. If this doesn’t help, 

please restart your computer and try again. 

Please also check our website www.rgb-laser.com for software updates. 

If the software still cannot find the device, you may check the Device Manager in the 

Windows Control Panel. Your spectrometer should show up as ‘‘Qstick’’ in the 

‘‘Measurement and Control’’ branch. If your spectrometer is marked with an exclamation 

or question mark, please remove the device, uninstall the software from the Windows 

Control Panel, restart the computer and install the software again. 

If your spectrometer is not listed at all in the Device Manager, please try a different USB 

port. If the device does not work on one computer, but works on others, the USB port 

may not provide enough power for the spectrometer. In this case, you’ll need to use an 

externally powered USB hub. 

If this doesn’t help either, please contact our Technical Support Team (see chapter 5.1). 
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3 Operation 

3.1 Introduction 

Waves was designed from the ground up to provide a clean and straightforward user 

interface that does not stand in your way, without compromising advanced features or 

precision. 

If you are new to spectroscopy, you’ll find it easy to start using the software and taking 

spectra without having to worry about details like calibration or dark spectra. 

If you already have experience with other spectroscopy software, you’ll notice a few 

differences: 

o There is just one mode of operation that includes all relevant types of 

measurements (absorption, irradiance, scope and so on) through a consistent and 

clear interface. 

o Waves favors a simple self-explanatory terminology instead of complicated terms 

that need to be explained. For example, we use ‘‘Exposure time’’ instead of  

‘‘Integration time’’, because the average user doesn’t really know what’s being 

integrated here. 

o There are no wizards to help you with complicated tasks, because wizards tend to 

conceal the actual task. We believe it’s better to make these tasks accessible 

through a clear and unified interface, so that you can understand what’s going on. 

3.2 Overview 

When you start Waves, the software searches for an attached Qstick spectrometer. If it 

finds one, it automatically initializes it. Afterwards, the software presents the main 

window: 
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The main window consists of several panels: 

1. The Exposure Toolbar, where you can start and stop taking spectra and set the 

acquisition parameters. 

2. The Spectrum List shows all spectra that are currently in memory. 

3. The Properties Panel consists of four tab pages and displays many parameters and 

values of the spectrum currently selected in the Spectrum List. 

4. The Main Diagram Panel shows all spectra marked with a check mark in the list. 

5. The Display Parameters Panel determines how the spectra are displayed. 

In order to get more screen space for the main diagram, the other panels can be 

minimized by clicking on the buttons with two triangles next to the panel title. 

3.3 Taking Spectra 

In order to take a spectrum, just choose an exposure time or select auto exposure and 

click on one of the green buttons ([ ] for a single shot or [ ] to start a continuous 

measurement). You can increase the exposure time in order to decrease the noise level. If 

the amount of light detected during the exposure is too large for the CCD detector inside 

the spectrometer, the spectrum appears saturated and a red ‘‘OVERLOAD’’ warning 

appears at the top of the diagram. In this case, you need to decrease the exposure time. 

You can further increase the sensitivity by averaging across multiple exposures with the 

‘‘Temporal Averaging’’ setting. 

If a spectrum acquisition takes longer than one second, you can monitor the progress in 

the status bar at the bottom of the window. The acquisition may finish before the 

progress indication reaches the end position, because the spectrometer is triggering on 

the end of the exposure. You can stop the data acquisition by clicking on the red stop 

button [ ]. 

If you choose auto exposure, the exposure time for each new spectrum is set 

automatically based on the intensity of the previous spectrum. It may take a few spectra 

before the auto exposure control has reached its optimum. In auto exposure mode, you 
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can set a maximum exposure time in order to prevent very long exposure times in cases 

when there is simply no signal. 

Spectra can be taken with or without spectral sensitivity correction (see chapter 3.9 for 

more details). If the lightmeter button [ ] is selected, the spectral sensitivity of the 

spectrometer is automatically corrected and the intensity axis is measured in nW/nm. 

PLEASE NOTE: If you take a spectrum with spectral sensitivity correction, the noise in the 

spectrum is not evenly distributed, because some parts of the spectrum are more 

amplified than others. On the other hand, if this button is not selected, the spectral 

sensitivity is not corrected and the intensity axis displays values as they are produced by 

the spectrometer hardware. In this case, you may find an uneven distribution of the 

sensitivity across the spectrum. For precise measurements, it is recommended to turn on 

spectral sensitivity correction. 

Dark spectra for the spectrometer are stored in the device and used automatically when 

taking spectra (see chapter 3.9 for details). If you have background radiation, you can 

compensate for it by taking a background spectrum (see chapter 3.8). In the Exposure 

Toolbar you can also select the triggering mode and choose a reference spectrum for 

absorption, reflection and transmission spectroscopy (see chapter 3.8). 

3.4 Spectrum Display 

The Main Diagram Panel displays all spectra that are marked by a check mark in the 

Spectrum List. If no spectrum is checked in the list, then the currently selected spectrum 

(marked by a gray bar) is displayed. You can check and uncheck all spectra at once by 

clicking on the corresponding button [ ] or [ ] on top of the Spectrum List.  

The peaks in the spectra are automatically determined. This not only works pretty reliable 

for clearly defined peaks, but also for those lying in the side of another peak or those that 

are just above the noise level. If necessary, you can fine-tune the parameters for finding 

the peaks by choosing ‘‘Peak Finder Parameters’’ from the Tools menu. In this window 

you can choose three settings: 

o  ‘‘Absolute threshold’’ determines how much a peak must be above the noise level 

in order to be considered as a peak. 

o ‘‘Relative threshold’’ describes how large a peak must be compared to the local 

minima before and after it in order to be considered as a peak. 

o ‘‘Position threshold’’ determines how much of the top part of the peak is 

considered when calculating the peak position.  

Peak positions and widths are only displayed for the currently selected spectrum. The 

peak positions, heights and widths are also displayed in the Properties Panel and can be 

exported by choosing ‘‘Export Peaks’’ from the File menu. 

In the Display Parameters Panel below the diagram you can select how the spectra are 

displayed. These settings affect the diagram display, but do not modify the actual data. 

Here you can change the scaling of both axes, the unit of the wavelength axis, turn the 
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display of the grid, peak positions and peak heights on and off and see the coordinates of 

the current position of the mouse pointer. 

If you zoom into the wavelength axis, a scrollbar appears at the bottom of the diagram  

for easily moving the displayed part of the spectrum. Alternatively, you can grab and 

move the axis with the mouse. You can also drag the intensity axis in order to change the 

maximum value and quickly enlarge weaker parts of the spectrum. 

If you would like to determine the intensity value at the position of the mouse pointer 

relative to a reference value, just move the mouse to that reference value, click with the 

right mouse button and choose ‘‘Set reference level’’. 

You can select a single wavelength or a range of wavelengths by clicking or clicking and 

dragging in the diagram. This selection can be used to compare wavelength values, to 

display statistical data just for the selection (see chapter 3.5) and to zoom into it (by right-

clicking). 

3.5 Working with spectra 

In Waves, you can have several spectra loaded at the same time for easy comparison and 

analysis. On the upper left side you can see the Spectrum List. Whenever you take a new 

spectrum, it appears in this list as ‘‘current spectrum’’ and overwrites any previous 

‘‘current spectrum’’. If you would like to keep this spectrum and take another one, just 

click on the single push pin button [ ]. This prevents the current spectrum from being 

overwritten. A new spectrum you take is then appended to the list. Giving the ‘‘current 

spectrum’’ a new name also prevents it from being overwritten. You can also choose to 

keep all new spectra by selecting the button with multiple push pins [ ] in the Exposure 

Toolbar. 

When you have multiple spectra in the list, one spectrum is always selected (marked by a 

gray bar). All metadata and additional information for this spectrum is displayed in the 

Properties Panel on the lower left side. The Properties Panel has five Tab pages: 

o General: Displays spectrum metadata. ‘‘Name’’ corresponds to the name in the 

Spectrum List.  ‘‘User’’ is automatically set to the current Windows user name, but 

can be changed. ‘‘Sample’’, ‘‘Light’’ and ‘‘Comments’’ can be freely edited by the 

user.  You can change the color of the spectrum by clicking on the color box. Please 

note that ‘‘User’’, ‘‘Sample’’, ‘‘Light’’ and ‘‘Comments’’ is the same for all spectra in 

the list. 

o Values: Displays statistical values both for the whole spectrum and within the 

selection (if you have selected a range of wavelengths in the diagram). 

o Color: Displays colorimetric values. For precise color measurements please also 

read the section on calibration accuracy in chapter 3.9. 

o Peaks: Displays peak positions, heights and widths. This list can be save to a file by 

choosing ‘‘Export Peaks’’ from the file menu. 

o Data: Displays a list of all values of the spectrum. 
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Some of the values in the Properties Panel are saved when saving the spectrum to a file. 

The others are recalculated when the spectrum is reloaded. 

3.6 File Operations 

You can save the selected spectrum or the whole Spectrum List using the commands in 

the File menu. You can also open spectrum files to load them back into Waves for further 

evaluation (sounds obvious, but surprisingly, many spectroscopy applications don’t even 

support this). 

The file format for spectra is a simple ASCII table with columns delimited by the TAB 

character and some header lines containing the metadata. This allows the spectrum files 

saved by Waves to be read by almost any numerical analysis software like Origin, Excel or 

Matlab. The default file extension for these files is ‘‘.spz’’. If you click on an .spz file in 

Window Explorer, it is opened with the Waves application. 

In Waves, you can also open spectrum data files written by other applications, if they are 

saved as ASCII tables or .csv files. Waves tries its best to automatically determine the file 

structure and is able to open many different file formats.1 

You can print spectra by choosing ‘‘Print’’ from the file menu. If you choose the page 

orientation as ‘‘Landscape’’, the spectrum diagram is printed across the whole page. If 

you choose ‘‘Portrait’’, the diagram is printed on the upper half of the page and the lower 

half shows selected metadata and values. 

The printing options are designed for the most common tasks. If you have further specific 

requirements for printing, you may also decide to export the diagram and then use a 

graphical design software or word processor for printing. 

You can export the diagram either as a bitmap image or as a PDF vector graphic. Both 

options are available by choosing ‘‘Export’’ from the File menu. 

After choosing a file name, you can set the height and width of the image and the 

resolution, if applicable. Please note that the text sizes and line widths are constant. 

Therefore, if you choose a larger export size, the labels and line widths appear to be 

smaller. 

 

 

 

 

 

                                                                            
1 In case you have a spectrum file written as ASCII data and you are unable to open it in Waves, please 

contact our Technical Support Team and we’ll see if we can include an import filter for this file format. 
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3.7 Spectrum Analysis 

The Analysis menu offers several ways to evaluate and modify spectra: 

Adjust Offset 

This adds a constant value to all data points of the selected spectrum. The software 

suggests a estimated value for compensating an offset, but you may also choose any 

other value. 

Normalize 

This multiplies all data points of the selected spectrum by a constant factor. The default 

factor is chosen for the maximum value to be scaled to 100. 

Differentiate 

This differentiates the spectrum with respect to the wavelength. 

Spectral Averaging 

This substitutes each data point by the average of the surrounding data points. You can 

choose how many data points to include in the averaging. This is also known as ‘‘Boxcar 

Averaging’’. 

Arithmetic Operations 

This creates a new spectrum by adding, subtracting, multiplying or dividing two spectra. 

Adjust Wavelength 

This allows to assigns a new wavelength scale to all spectra in the list based on the 

parameters for the fourth-order polynomial function used for wavelength calibration. It 

may be useful if you took spectra with an incorrect wavelength calibration. 

Duplicate 

This creates a copy of the selected spectrum and may be useful if you would like to 

modify a spectrum, but also keep the original one. 

Peak Width Diagram 

This opens a window displaying the widths of the detected peaks (Full width at half 

maximum). 
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Show Strip Chart 

You can use the Strip Chart window to display a characteristic spectrum value as a 

function of another value for all spectra in the list. The most common task is to display 

the temporal evolution of a characteristic value. This window can be kept open while 

taking new spectra to see the changes as they happen. 

In the lower left side of the Strip Chart window, you can choose which values to assign to 

the x and y axis of the chart. You can choose all numerical values that are displayed in the 

Properties Panel in the main window. If you want to view the temporal evolution of a 

value, choose this value for the y axis and either ‘‘Number in List’’ or ‘‘Time’’ for the x axis. 

If you choose ‘‘Value from name’’ as x or y axis, the software tries parse the name of each 

spectrum into a number. So for example, if you have a list of spectra that are named ‘‘T = 

10.3 °C’’, ‘‘T = 15.2 °C’’ and so on and you choose ‘‘Value from name’’, these temperature 

value are used for the corresponding axis. 

In the Strip Chart diagram, the currently selected spectrum is marked by a slightly larger 

point. Points corresponding to spectra that are currently not visible in the main window 

are drawn in a lighter red color.  

Show Loupe 

This opens a window with a magnified display of the spectrum around the mouse 

pointer. It may be used in order to study small features in the spectrum as an alternative 

to zooming in. 

3.8 Absorption, Reflection and Transmission Measurements 

Principle 

In absorption, reflection and transmission spectroscopy you direct light from a 

broadband light source onto a sample. Then you take a spectrum �(λ) of the light that is 

transmitted through or reflected from the sample. In order to get meaningful results that 

are independent of the light source, you also take a spectrum of the light source ��(λ)  as 

a reference. 

The spectral transmittance �(λ) or reflectance is then simply the fraction of transmitted 

or reflected light: 

�(λ) = 	
�(λ)

��(λ)
	 

This formula gives values in the range between 0 and 1. The transmittance is usually 

written as a percentage. The spectral absorbance 	(λ)	is defined as: 

	(λ) = log
��(λ)

�(λ)
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Please note that the absorbance is sometimes defined as the base 10 logarithm and 

sometimes as the natural (base e) logarithm. In Waves, you can choose in the Options 

window from the File menu which logarithm to use. 

Measurement 

In order to measure absorption, reflection or transmission you need to take a reference 

spectrum of the light source first. If your measurement setup is not in complete darkness, 

it is also generally recommended to take a background spectrum before the 

measurement. 

To take a background spectrum, turn off the light source, set an appropriate exposure 

time and click the ‘‘Take Background Spectrum’’ button [ ] on the Exposure Toolbar. In 

order to minimize noise, you may also want to use temporal averaging. When you’ve 

taken a background spectrum, you can select the ‘‘Use Background Spectrum’’ button [

]. If you take a spectrum afterwards, the background spectrum is automatically 

subtracted from the measured spectrum, eliminating unwanted background signals. 

To take a reference spectrum for transmission or absorption spectroscopy, turn on the 

light source again, remove the sample, set an appropriate exposure time and temporal 

averaging and click the ‘‘Take Reference Spectrum’’ button [ ]. After selecting the ‘‘Use 

Reference Spectrum’’ button [ ], you can take spectra of your sample for measuring 

absorption or transmission. 

To take a reference spectrum for reflection spectroscopy, you need a white reference 

sample to calibrate the setup for 100 % reflection. However, all real-world reference 

samples have a reflection of less than 100 % and an uneven spectral distribution. 

Therefore, for accurate measurements you also need to supply a reference spectrum for 

your reference sample. To take a reference spectrum, place the white reference sample 

where you’ll later place the sample to be measured. Then set an appropriate exposure 

time and temporal averaging and click the ‘‘Take Reference Spectrum’’ button [ ]. In the 

following dialog window, you can also specify a data file that includes a calibrated 

spectrum of your reference sample. After selecting the ‘‘Use Reference Spectrum’’ button 

[ ], you can measure reflectivity spectra. 

The y axis of the spectrum now shows the relative intensity of the measured spectrum 

compared to the reference spectrum. In the ‘‘Options’’ dialog from the File menu you can 

choose different units for displaying the spectra: 

o Ratio shows the ratio of the measured spectrum to the reference spectrum as in 

the formula for �(λ) above. 

o Percentage shows the same value �(λ), but written as a percentage (i.e. multiplied 

by 100).2 This unit is usually used for transmittance. 

o Absorbance shows the spectral absorbance 	(λ) according to the formula above. 

You can choose between natural and base 10 logarithm. 

                                                                            
2  Please note that „percent‘‘ means nothing else than ‘‘divided by 100’’. 
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These options only determine how to display the spectra in the diagram. The do not 

modify the actual spectrum data. 

If your light source does not cover the full range of the spectrometer, the calculated 

spectrum may show large amounts of noise outside of the wavelength range of your 

light source. This is normal and reflects the fact that the measurement has a large 

uncertainty at these wavelengths. 

These measurements are quite sensitive to changes of the sample illumination. If in 

doubt, you may want to take another reference spectrum to check if it is still valid. 

3.9 Calibration 

The calibration for the wavelengths, dark spectra and spectral sensitivity are stored on 

the device and loaded automatically during device initialization. So in contrast to almost 

any other spectroscopy software, you don’t need to worry about taking dark spectra and 

other calibration parameters, it’s all done automatically. 

If the device has been used for a long time or if you need a very precise measurement, 

you can easily recalibrate the spectrometer within Waves, if you have a suitable light 

source. Recalibration may also be required if the device temperature is outside of the 

calibrated temperature range. The device temperature is continuously monitored by the 

spectrometer and a warning is displayed, if the temperature has changed considerably. 

After you have recalibrated the spectrometer, you can always restore the factory 

calibration in the ‘‘Device Properties’’ window from the File menu. 

Calibration Accuracy 

The wavelength calibration is very accurate and changes only little with time or 

temperature. Therefore, most users won’t ever need to recalibrate the wavelengths. 

The dark spectrum calibration depends on the temperature. If the temperature has 

changed considerably, a warning message is displayed recommending recalibration. 

However, if in doubt or if you need as little noise as possible, you can always easily 

recalibrate it because no calibration light source is required. 

The calibration for the spectral sensitivity depends a lot on your optical fiber, your 

measurement probe and how the light is coupled into the spectrometer. During 

production of the Qstick spectrometer, we don’t know what your optical setup is going 

to be. Therefore the factory calibration for the spectral sensitivity and especially the 

absolute intensity is not to be considered as a precise measurement, but rather as a first 

estimate. If you require precise intensity measurements, you’ll have to recalibrate the 

sensitivity of the whole system including fiber and probe. 

In addition, please note that after changing the exposure time, it takes a few spectra 

before the CCD sensor inside the spectrometer reaches its new equilibrium. This means 

that after changing the exposure time, the intensities of the following 5 to 10 spectra 
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may not be as accurate as later measurements. Therefore, for precise measurements we 

recommend not to use the auto-exposure feature and to set a fixed exposure time 

instead. 

Wavelengths 

The mapping of the individual pixels of the spectrum to wavelengths is done using a 

third-order polynomial. The four parameters for this function are measured during 

manufacturing and stored in the device. Usually, this wavelength calibration does not 

change. Therefore, in most cases you don’t need to recalibrate the wavelengths. 

However, if the ambient temperature has changed substantially, if the device has been 

used for a very long time or if you just would like to make sure that the wavelengths are 

really correct, you can recalibrate the wavelength if you have a suitable light source with 

several sharp atomic emission lines. These wavelength calibration sources are usually 

low-pressure gas discharge lamps filled with Krypton, Neon, Mercury, Argon or Xenon 

gas. 

To recalibrate, take a spectrum of this light source first. Make sure that the relevant peaks 

are automatically detected. If not, adjust the ‘‘Peak Finder Parameters’’ in the Tools Menu. 

Then choose ‘‘Calibrate Wavelengths’’ from the Tools menu. In the ‘‘Reference Spectrum’’ 

combo box select the type of light source used. If you don’t find your light source in the 

list, you need to supply your own calibration lines. In this case, please take a look at the 

‘‘CalibrationLines xxx.dat’’ files in the installation folder on your hard drive and 

create a new similar file containing the spectrum lines of your light source. 

After you have selected your light source, click on ‘‘Start Fit’’. The software tries to match 

the peaks in the measured spectrum and the given spectrum lines for your light source 

automatically. Not all of the given spectrum lines have to be present in the measured 

spectrum, but all measured peaks must be known spectrum lines. If a match has been 

found, the average deviation is displayed. If the match seems to be successful, it is 

displayed in green, otherwise in red. You can also graphically display the deviations by 

clicking on ‘‘Show Deviations’’. If the measured peaks have successfully been identified, 

you can set the four new wavelength calibration parameters by clicking on the ‘‘Save’’ 

button and confirm by clicking ‘‘OK’’. The new wavelength calibration is then saved to the 

device. 

Dark Spectra 

Inside the Qstick spectrometer, the spectra are detected with a CCD line sensor. Like all 

image sensors, this sensor detects a small signal even if there is no light entering the 

spectrometer. This signal depends on the individual pixel, the exposure time and the 

temperature. In order to obtain a precise measurement with a small noise level, this ‘‘Dark 

Spectrum’’ must be taken while no light enters the spectrometer and then subtracted 

from the actual measurement. 
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For your Qstick spectrometer, this dark spectrum has already been taken, is stored in the 

device and automatically subtracted from the measured spectrum each time you take a 

new spectrum. Because the dark spectrum depends on the exposure time in a non-linear 

way, there are actually multiple dark spectra stored in the device for a certain number of 

exposure times. The dark spectrum that is needed for a chosen exposure time is then  

obtained by interpolating between these dark spectra. 

In case you find that the spectra you get are not zero on the average, even if no light 

enters the spectrometer, then you probably need to recalibrate the dark spectra. You can 

also check the dark spectrum calibration using the ‘‘Calibrate Dark Spectrum’’ window 

(see below). 

To recalibrate the dark spectra, simply close the spectrometer entrance, make sure that 

no light enters the device and choose ‘‘Calibrate Dark Spectrum’’ from the Tools menu. 

Then click the ‘‘Take’’ button and go for a coffee. After a few minutes the software has 

taken dark spectra for a series of exposure times. You can check the new dark spectra by 

clicking on the ‘‘Test Button’’.  While the test is running, you can in the lower diagram the 

spectra taken without (red) and with (green) dark spectrum correction. In the upper 

diagram you can see the noise level, also without (red) and with (green) dark spectrum 

correction for a series of exposure times. You can see that the noise level of the raw data 

(red) increases significantly with increasing exposure time. With dark spectrum correction 

(green) however, the noise level should remain pretty much at the same level for 

exposure times less than 1 second and increase slower for exposure times larger than 1 

second. If you find this to be the case, close the window by clicking on the ‘‘OK’’ button 

and the new dark spectrum calibration is saved into the device.  Otherwise you may 

calibrate again or click ‘‘Cancel’’. 

Spectral Sensitivity 

Like in all spectrometers, the sensitivity of the Qstick spectrometer is not uniform across 

the spectrum, but depends on the wavelength. This is called ‘‘Spectral Sensitivity’’ and 

can be corrected by dividing each value of the spectrum by the corresponding sensitivity. 

This sensitivity calibration is also stored in the device. However, it is not always used 

when taking spectra, because if the sensitivity is corrected, the noise level is unevenly 

distributed across the spectrum. Instead, you can choose to use the spectral sensitivity 

correction by selecting the ‘‘lightmeter’’ button in the Exposure Toolbar. 

If you would like to recalibrate the spectral sensitivity, you need a light source with a 

continuous spectrum (like a tungsten halogen lamp) and a calibrated spectrum for this 

lamp. 

To recalibrate, take a spectrum of your light source with spectral sensitivity correction 

turned off. Make sure the spectrum contains as little noise as possible by using a strong 

light source, a suitable exposure time and use Temporal Averaging. Then choose 

‘‘Calibrate Spectral Sensitivity’’ from the Tools menu. Click on the ‘‘Load reference data’’ 

button to load the calibrated reference spectrum (in other words: a spectrum file that 

shows how your light source really looks like). Based on the measured spectrum and this 
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file, the software calculated the spectral sensitivity of your spectrometer and shows it as a 

dark green line. To save this new calibration to the device, click ‘‘OK’’. 

If you also want to calibrate the absolute scale of the intensity axis, you need to take a 

spectrum and also need to know the absolute optical power (in Watts) of this spectrum. If 

you measure the actual optical power with an optical powermeter, please make sure that 

the powermeter only detects wavelengths that are within the wavelength range of your 

spectrometer (for example by choosing a suitable light source). Then choose ‘‘Calibrate 

power’’ from the Tools menu and enter the actual power. If you click ‘‘OK’’, the new power 

calibration is stored in the device and used for scaling the intensity axis. This axis then 

displays the spectral power density in nW/nm. 

In addition, you don’t have to calibrate the power at the spectrometer entrance. For 

instance, you could calibrate the power that enters your measurement probe or any 

other power in your setup, as long as it is proportional to the power that enters the 

spectrometer. Just remember that the optical powers and power densities displayed by 

the software refer to this value. 
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4 Software Development Kit 

The Software Development Kit (SDK) for the Qstick spectrometer can be used to control 

the spectrometer and take spectra from your own custom software. It includes a 

Windows Dynamic Link Library (DLL) for the .NET framework, documentation and sample 

code. 

4.1 Prerequisites 

The system requirements are the same as for Waves (see chapter 1.2). 

You can use the SDK with any programming language that can connect to .NET DLLs. This 

includes C#, Visual Basic .NET, C++/CLI, Delphi, LabView, Matlab and Mathematica. If you 

are using a programming language that can connect to COM, but not to .NET libraries, 

you may need to use Microsoft’s Assembly Registration Tool (Regasm.exe). 

You should have a basic understanding of the concepts of object-oriented programming 

in order to understand the structure and functionality of the SDK library. 

4.2 Getting started 

In order to get familiar with the SDK quickly, we suggest to: 

1. Read the next chapter 4.3 to understand the structure of the SDK library. 

2. Read the basic steps required in order to take a spectrum (chapter 4.5). 

3. Study the sample projects included in the SDK. 

4. Add the SDK library to your own project (chapter 4.4). 

5. Implement the basic functionality of taking a spectrum in your project. 

6. Implement advanced features as required. 

4.3 Classes Overview 

The SDK library contains classes for controlling a spectrometer or laser as well as abstract 

base classes for various types of measurement and control devices. 

The main class that you need in order to communicate with the spectrometer is: 
          Qstick 

              which is a descendant of the ExtendedSpectrometer class, 

                  which is a descendant of the Spectrometer class, 

                      which is a descendant of the Device class. 

 

The Device class includes basic features used by all kinds of measurement and control 

devices. Spectrometer is a base class for a simple spectrometer. 
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ExtendedSpectrometer is a base class for a spectrometer with more features. Qstick 

implements all the features specified in the abstract base classes in order to control a 

Qstick spectrometer. 

The library also includes the SimulatedSpectrometer class, that may be used instead 

to test your software in case you don't have a real device available, just like choosing 

‘‘Simulated Spectrometer’’ in Waves. However, this class is currently only a descendant of 

the Spectrometer class and does not support the additional features in 

ExtendedSpectrometer. 

You can find the full documentation for all relevant classes in the SDK documentation 

contained in the RgbDriverKit documentation.chm help file. 

4.4 Adding the SDK library to your project 

The library to connect to your spectrometer is in the RgbDriverKit.dll file. Please 

copy it to your main project folder. The Qstick device driver for Windows, which is 

installed during the installation of Waves, must also be present. 

Visual Studio 

If you are using one of Microsoft’s languages, please add both libraries in Visual Studio to 

your project references (in the Solution Explorer window). Then import the 

RgbDriverKit library to your source code files (for example in C# or C++: ‘‘using 

RgbDriverKit;’’). For enhanced IntelliSense support in Visual Studio, you may also 

want to copy the RgbDriverKit.xml file into the same folder as the library. 

LabVIEW 

In order to use a .NET DLL in LabVIEW, you need to: 

o Use the .NET palette (Connectivity -> .NET) to find all of the functions available. 

o Use a constructor node in order to instantiate a class within the .NET assembly. 

o Use property nodes and invoke nodes to access properties and methods of the 

class by wiring in the class reference from the constructor node to the property or 

invoke node. 

Specific LabVIEW VIs for controlling the Qstick spectrometer are planned for a later 

release of the SDK. 

Other languages 

For more information on how to connect to the library from other programming 

languages, please try a Google search for something like ‘‘use .NET DLL in [your 

language]’’. 

For example, users of Matlab may find useful information at: 
http://www.mathworks.de/help/techdoc/matlab_external/brpb5k6.html 
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4.5 Taking a spectrum 

First you need to instantiate a Qstick object to control your spectrometer. You could 

use the class constructor, of course, but in most cases it’ll be easier to search for 

spectrometers by calling the static SearchDevices() method and then choose from 

one of the returned objects, which are actual instances of the Qstick class. 

Then, the steps required for taking a simple spectrum are: 

1. Open the connection to the device using the Open() method. 

2. If you need the wavelengths, get an array containing the wavelengths of each 

pixel with GetWavelengths(). 

3. Set the exposure time using the ExposureTime property. 

4. Start the exposure with the StartExposure() method. 

5. Wait (or do something else) while the Status property is 

SpectrometerStatus.TakingSpectrum. 

6. Read the spectrum with the GetData() method. 

The full documentation for these methods and properties can be found in the 

RgbDriverKit documentation.chm help file. 

All methods and some properties may throw an exception as described in the SDK 

documentation help file. Always make sure that these exceptions are properly handled 

by placing these methods inside a try{} catch{} block. 

4.6 Deploying your project 

If you would like to deploy your project to other users, please: 

o Include the library file RgbDriverKit.dll. 

o Make sure that the .NET framework 3.5 is installed. 

o Make sure that the Qstick device driver is installed. 

The device driver is normally installed during the installation of Waves. If you would like 

to use the spectrometer without installing Waves, you can find the files for the device 

driver in the ‘‘Qstick driver’’ folder in the program folder of a Waves installation. 
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5 Technical Support 

5.1 Getting Help 

If you have any questions, comments or requests concerning your Qstick spectrometer or 

the Waves software, please go to 

http://www.rgb-laser.com 

click on ‘‘Contact’’ on the menu bar. 

There you’ll also find details on how to contact our Technical Support Team via e-mail or 

telephone. 

5.2 Software Updates 

Software Updates are expected to be released about twice a year. To check for updates, 

you can choose ‘‘Check for Updates’’ from the Help menu or go to the ‘‘Support’’ section 

on our website www.rgb-laser.com. 

These are some of the features planned for future software releases (subject to change): 

o More colorimetry values and options 

o More options for printing and export 

o Working with multiple spectrometers 

o More spectrum analysis features 
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6 Specifications 

Optical 

Wavelength range: 360 - 740 nm 

Numerical Aperture: 0.07 

Grating: 1800 lines/mm 

Entrance slit: 30 µm 

Spectral resolution (FWHM):  1.2 nm 

Stray light: < 0.5 % 

Optical interface: SMA connector 

Electronic 

Dynamic range: 300 : 1 (full scale, texp = 1 s) 

Detector: 2500 pixel linear CCD detector 

  

A/D converter: 16 bit 15 MHz 

Calibration: Wavelength, sensitivity and multiple dark spectra stored 

 within the device 

Transfer speed to PC: 20 ms per spectrum 

Digital Interface: USB 2.0 

  

Power supply: 5 V DC via USB (no power adapter required) 

Power consumption: typical: 200 mA 

PC operating system: Windows 7, Vista, XP 

Mechanical 

Dimensions: 75.8 × 22.0 × 10.2 mm 

Weight: 25 g 

Operating temperature: -15°C to 60°C (non-condensing) 

Storage temperature: -25°C to 70°C 
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7 Certifications and Compliance 

 

 

 

 

 

RoHS Declaration of Conformity 

 

The manufacturer 

 
  RGB Lasersysteme GmbH 

  Donaupark 13 

  93309 Kelheim 

 

declares that the following product 

 
  Qstick  Version 1.0 

 

contains no toxic substances which are specified in the 

 
  RoHS Directive 2002/95/EG. 

 

The conformity to RoHS Directive 2002/95/EG is confirmed. 

 

This declaration applies to all models of the above named product 

version. 

 

 

Kelheim, 09.06.2012    Mathias Reichl 

 


